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Introduction  

Welcome to an exciting new world of Electronic Advertising.  Your new LED Display is a 
powerful advertising tool with great potential for promoting your products and services.  

MediaEditor is a software package used to create message files for use with your new 
LED display.  With the ability to combine text, images, and video along with a variety of 
transitions and effects, MediaEditor is a powerful tool for communicating your message 
to an audience.  This manual is to provide you with a firm foundation to begin utilizing 
your new display to its full potential.  



MediaEditor Users Guide   
Copyright Optec Displays 2004  Page 4 of 21 

Software Installation  

To begin using the MediaEditor Software, it must first be installed on your computer.  It 
is important to note that if MediaEditor is to be installed on a computer operating under 
Windows 2000 or Windows XP, administrative privileges are required.  If you do not 
have administrative privileges or are unsure, please contact your system administrator 
for assistance.  

1. Insert the CD-Rom into your CD-drive. 
2. The installation program should begin automatically.  In the case that the 

program does not begin automatically proceed as follows. 
A. Click the "My Computer" icon located either on the "Start" menu in 

windows or on the Desktop. 
B. Double Click on the CD-Rom Drive 
C. Double Click on the program named "Setup.exe"  

3. You will be prompted to begin the installation of the MediaEditor 2 software.  
Click yes to proceed. 

4. Follow the On-Screen prompts in the installation software, clicking "Next" to 
proceed.  After all information about the installation is gathered the "Ready To 
Install" dialog box will appear, Click "Install" to complete the installation of 
MediaEditor. 

5. After the successful installation of MediaEditor, a shortcut will be created on your 
desktop and Start Menu.  

If you encounter any difficulty during the installation of MediaEditor, please contact 
your Authorized Optec Dealer for Assistance.  

Starting MediaEditor 
Locate the MediaEditor shortcut on your Windows Desktop and double-click to begin.  
Alternatively you may also locate the program on your Windows Start Menu and click to 
begin.  
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The MediaEditor Interface 
It is important to first learn about the different components that make up the MediaEditor 
Interface.  It is recommended that you open your software and look at the items shown 
below to become familiar with their location.  

  

General Interface Definitions 

Clipboard This area, made of object cells, is used to create and hold images, 
text and videos which are the building blocks of your messages. 

Menu A standard menu bar containing file and edit commands used in 
editing frames and messages 

Frame The What You See Is What You Get (WYSIWIG) area.  This area is 
used to create a portion of your message file.  A message may 
contain a single frame or be comprised of a collection of frames.  
The frame represents your display. 

Sprite 
Inspector 

The Sprite Inspector contains a reference list of objects used from 
the clipboard in each frame.  The information listed will show only 
the objects utilized in the current frame.  
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Menu Definitions 

File Commands for creating, saving, and exporting of messages 

Edit Commands for Undo, Cut, Copy and Paste Functions 

Add Commands to Add Frame, Repeat Frame, Import Images, Text, and Videos 

View Allows for the selection of what portions of the interface are displayed and 
frame magnification levels 

Run Provides a real-mode preview of the entire message 

Option Display Size Selection and type are selected in this menu 

Help Displays the current version and copyright information. 

Clipboard Toolbar Definitions 

Image Import Imports a new static image into the clipboard 

New Text Creates new text sprite 

Video Import Imports new video file into the clipboard 

Token Creates run-time variable information such as Time, Day of the Week, 
and Temperature for use in messages 

Properties Opens the properties window for the selected sprite for either preview 
or editing features 

Frame Toolbar Definitions 

Normal 
Frame 

A normal frame can contain any combination of clipboard items such 
as text displayed in coordination with a background image or video 

Text Frame A text frame is a special frame in which text is input in a line by line 
mode.  The text frame does not allow for any sprites from the clipboard 
to be inserted 

Frame 
Property 

Opens the frame property dialog box where transition, background and 
hold time information is assigned 

Preview Provides a real-mode preview of the individual frame 

Remove 
Frame 

Removes the selected frame from the message 
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Getting Started 
Now that you are familiar with the menus and toolbars in MediaEditor, it is time to begin 
creating messages.  As you move along through this part of the manual you will be 
presented with information in step-by-step fashion, it is a good idea use the manual in 
conjunction with the MediaEditor software to reinforce what you are learning.  

Setting Display Size and Type 
In order for the messages you create in MediaEditor to appear properly on your display 
you must set the software to match the display matrix.    

1. Select "Set Sign Size" from the "Option" Menu 
2. The "Sign Size" dialog box will appear 
3. Using either the mouse or simply type in the values for height and width that 

match your specific display. 
4. Click OK to apply those changes to MediaEditor.  

  

It is not necessary to set the Sign Size each time you begin MediaEditor as this 
information is stored as the new default.  Equally as important as the Sign Size is the 
type of display, which is set by choosing the appropriate color capabilities of your 
display from the "Options" menu.  By setting the displays color capabilities you will be 
creating and editing messages as they will be shown on your display.  
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Text Only Messages 

The simplest message to create will use the "Text Frame" and consist only of text.  
Using only text is an efficient method of communicating large amounts of information in 
a short time period. 

1. For this example set the Sign Size to be 80 wide by 16 high.  Set the color 
capabilities to "Amber Scale" 

2. Begin with a New Movie by selecting the "File" menu and clicking on "New 
Movie".  

3. Click on the "Text Frame" button in the Frame Toolbar.  At this point the text 
toolbar and line presentation window will be displayed as shown in diagram 
two. In addition the text entry cursor will be displayed in the current frame.  

  

4. Set the Font to "Terminal" with a size of "6". 
5. Type the following information using the "Enter Key" between each line and 

then click on the "Center Justification Button"    
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You have just successfully created a message. Continuing with this frame you will now 
add some line presentation functions to this text.  Line presentation functions control 
how text information enters and leaves the display.  As you input the text in the previous 
example you should have noticed the "Line Presentation" area to the left of the frame 
changing.  Each line of text can be independently assigned presentation functions or 
assigned globally.  Utilizing presentation functions effectively allow you to create 
attention grabbing messages.  

1. Click in the top half of the "Line Presentation" area.  The "Function Dialog" will 
appear.  

2. Select "Scroll Up" from the appear function side. 
3. Set the "Wait" to "10" 
4. Select "Shift Up" from the disappear function side and Click "OK" to assign these 

functions to line 1 of your message.  

  

You will notice that the top section of the "Line Presentation" area has changed from 
"05" to "U 10 u", for Scroll up, Wait 1 second, Scroll up.  As you become familiar with 
the functions you will be able to tell what each line is going to do just from referencing 
this area.  

5. Click the "Preview" button on the frame toolbar to see the changes you have 
made.  You will notice that the top line must complete all functions assigned 
before the second line appears. 

6. Select "Global" from "Text Only Frame" Toolbar.  You will notice that the "Line 
Presentation" area is no longer divided into two areas and is now shaded yellow.  
Click the "Preview" Button; you will notice that both lines now follow the 
presentation function simultaneously.  
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7. Click "Add" on the menu bar and select "Frame".  A new frame will be created.  
The frame should be defaulted to a "Text Only" frame, if not select the "Text 
Only" button. 

8. Change the font size to "16" and in the empty frame type "HELLO WORLD"; do 
not be concerned that all the information does not fit within the frame. 

9. Assign the appear function to "Scrolling Text" with a speed of "2" and preview the 
frame. Anytime the information you type does not fit within the frame you must 
assign the presentation function appropriately so that all the information is 
displayed. 

10. Add another frame to your message and enter the following:   
1st Line: "SEE JACK"   
2nd Line: "RUN, JUMP AND PLAY"  

Be sure to center the information using the "Center Justification" button.  

11. Assign the top line presentation function to "Full Open" for appear, Wait "05", and 
"Static" for disappear.  Assign the bottom line presentation function to "Scrolling 
Text". 

12. Click "Run" from the menu bar and select "Play Movie", a new window will 
appear and display your entire message file. 

13. Click "File" and select "Save Movie".  Name this message "First Message" and 
click save in the "Save Media File" dialog box.  Now you can retrieve this 
information for editing in the future.  

One method of storing messages to be shown on your display is to export to an AVI 
file, for a complete description of AVI files and the pros and cons of exporting to AVI, 
please read the next section regarding AVI files. 
   
14. On the file menu select "Export to AVI". 
15. A dialog box will appear.  Name the file "First Message".  Click the "Save" Button, 

after the file is exported as indicated by the progress bar, click "Exit". Your first 
message is now ready to be scheduled for display.  
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You have learned how to create text only messages, assign presentation functions and 
save and export your work.  The principles you have learned can be utilized for any size 
display.  Set your sign size to match your display and take some time and practice 
creating some text only messages. Change your font, font size, colors, and presentation 
functions.  Once you feel comfortable with these items move on to the next section of 
the manual where you will learn to add images and videos to your messages.  

Export to AVI 
The MediaEditor player / scheduler will allow you to use two types of files, AVI and the 
native .MED MediaEditor file.  There are some important items to consider when 
choosing which file to use when storing your messages.    

AVI stands for Audio Video Interleave and is a widely used format for video files.  Each 
frame of your message will be rendered to create the video file, much like stop action 
animation on film.  

AVI files can be stored using a variety of third party codecs.  A codec is a piece of 
software that compresses, encodes and decodes files.  While MediaEditor does not 
install any codecs, it is able to use any codec installed on your computer.  The most 
important item to note is that the codec must be available on both the computer you 
create the AVI file with and the sign controller.  If the codec is not installed on the 
controller the file will be unable to be decoded for proper display.  

Compressing AVI files results in a file that is significantly smaller data wise, which is 
advantageous when transmitting over low speed connections such as telephone and 
cellular modems.  The trade-off is the possibility of a lower quality file due to the 
compression algorithms.   

When you message contains mostly text and static images the native .MED file that is 
created by MediaEditor when you save your files may result in a smaller file.  The 
reason is that the .MED file uses a lossless compression method and stores only the 
text, images, video files and transition codes, instead of rendering each frame.  This 
information is then decoded in real-time by the sign controller.  

Take the time to experiment with AVI files, different compression codecs, and .MED 
files to see which is best for your particular situation. 

Advanced Messages 
In order to begin creating higher level messages which incorporate graphics and videos 
we must first learn to import sprites.    
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Setup 
1. Start a New Movie. 
2. Now set MediaEditor for a sign size of 96 wide by 40 high and select the "True 

Color" color capability.  If at any point the frame portion of MediaEditor is not 
completely visible you can change the zoom level by clicking the "View" menu 
and changing the zoom level.  

Creating Text Sprites 
You will begin by creating a text sprite. This is similar to the first example except the text 
sprites will be able to be placed anywhere in the frame.  

1. On the clipboard toolbar click the "New Text" toolbar. 
2. A "Text" window will open.  This should be familiar to you as it is the same as 

creating a "Text Only" Frame. 
3. Change the Font to "Times New Roman", set size to "10" 
4. Set your "Foreground Color" to a shade of red  
5. Change the "Character Offset" to "1", which will increase the space between 

characters.  
6. Select "Bold"  
7. Enter Text: "WEATHER"  

  

8. Click OK to complete the text sprite.  

The new text sprite you created is now located in the clipboard and ready to be 
inserted into the frame.  Next you will import an image for use in this example. 

Importing Images 
MediaEditor allows you import graphics in .BMP, .GIF, .JPG, and .WMF file formats.  
Graphics of this type may be found at many internet sites, created using Windows 
Paintbrush, or drawn in MediaEditor itself.  

1. Click the "New Image" button on the clipboard and select "New Bitmap (from 
File)" 
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2. Locate the file named "Partly Cloudy.gif".  This file is located in the folder named 
"Demo" inside the folder that you installed MediaEditor to. 

3. Click Open to begin the import process. 
4. The "Import AVI" dialog box opens with a sample of the graphic.  You will notice 

that the size of this file is 215 pixels wide x 142 pixels wide.  Since you are 
working with a sign size of 96 pixels wide x 40 pixels tall you will need to change 
the "Output Scale" to "Fit to Sign Height", which will scale the image 
proportionally to 40 pixels high by, in this case, 60 pixels wide.  

   

5. Click OK to complete the importing of your graphic.  

Your graphic and text sprites should now be in the clipboard and ready for insertion 
into the frame to build your message. You will need one more sprite to before 
beginning to build your message frame.    
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Creating Token Sprites 
Information that changes at the time of display such as time, date, and temperature are 
called tokens.  Token sprites are merely placeholders in our message that the display 
will replace with the most proper information when presented on the display.  

1. Click the "New Token" button on the clipboard toolbar. 
2. The "Token Editor" will be displayed. 
3. From the "Type" list select the item "Temperature .F"  

  

4. Click the "Font" Button. The "Font" editor will be opened. 
5. From the "Color" List Select Yellow. Click OK to apply this change.  

  

6. Click OK in the "Token Editor" to complete the creation of the Token Sprite.  

You now have all the building blocks for this portion of your message.  You now will 
assemble the frame for use in your message.   
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Assembling the Frame 
You will now assemble the frame, assign display effects, and preview your frame. 

1. Select the object cell containing the text sprite you created called "1: TEXT1" 
2. Click and Drag the text sprite into the frame. The text sprite will appear in the 

frame.  Using your mouse click and drag the text sprite to position it in the frame 
so that it is centered at the top of the frame.  

  

3. Continue by adding the image sprite to the frame.  Position the image sprite to 
the right side of the frame. 

4. You will notice the sprite is outlined in by a yellow frame with yellow squares 
spaced around the frame.  These squares are called handles.  Handles are used 
to resize a sprite in the frame.  Resize the image sprite by clicking and dragging 
the upper left handle to shrink the image slightly. Try to make it look like the 
example below.  Holding the <CTRL> key while resizing an image will maintain 
the original proportions of the image.  

  

5. The frame contains invisible layers on which sprites may be placed.  Right 
mouse click on the image sprite and select "Push Back" from the pop up menu.  
You will notice that the image sprite no longer obstructs the view of the text 
sprite. 

6. Add the token sprite to the frame and position it to the left side of the frame, 
vertically centered with the image sprite. Your frame should look like the example 
below.  
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